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Very Important

Be aware that the program analyzes the embedded retain-
ing walls as structural elements subjected to the lateral 
pressures of the different soils and exterior loads applied 
to them. 

Geotechnical calculations, such as the determination of 
the end bearing resistance, frictional resistance, groundwa-
ter flow, etc., are not carried out and they must be the sub-
ject of an accompanying study based on the Geotechnical 
report. The same applies for elements like braces or struts, 
type of anchor, its diameter, anchorage length, etc., which 
also require a separate study. 

1.1. Analysis Model
The analysis model employed consists of a vertical bar 
whose mechanical properties are obtained by transverse 
linear foot of wall. On this wall acts: the soil, in the exterior 
as well as the interior, the loads on the ground, the lateral 
support elements such as struts, active anchors, passive 
anchors, or construction elements like floor slabs, and the 
loads applied at the top of the wall. 

The introduction of lateral support elements such as 
struts, active anchors and passive anchors, establish 
exterior conditions on the wall, which are modelled as 
springs with the same stiffness as the axial stiffness of the 
element.

When a rock layer is introduced, the program considers 
the wall fixed if it is embedded into the layer for a length 
equal to or greater than two times the wall thickness. Be-
tween 8 in. and two times the thickness, the wall is consid-
ered to be simply supported by such layer, that is, rotation 
is allowed but displacement is restrained. 

The discretization of the wall is carried out every 10 in., 
obtaining the soil behavior diagram at each point. Fur-
thermore, the model also includes the points at which the 
lateral supports act.

1.2. Lateral Pressures
The lateral pressures that the soil exerts on the wall 
depend on the wall’s movement. To take this interaction 
into account, the program makes use of soil behavior 
diagrams like the one shown in the following figure:

1. Calculations
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8 Soil Retention Elements

Fig. 1.1

The critical points in the graph, ea, ep, and eo, are the
known active, passive, and at rest pressures, respectively.
The active and passive displacement limits are represented
by δa and δp. These displacements are obtained through
the active and passive Subgrade Moduli introduced by the
user.

The program calculates the coefficients of earth pressure
based on the following formulations:

- At rest earth pressure: Jaky formulation

- Active earth pressure: Coulomb formulation

- Passive earth pressure: Rankine formulation

To obtain information on the calculation of these pressures,
consult the Earth pressure calculations in section 3.

The values for the Subgrade Modulus, like any geotechnical
parameter, are difficult to estimate. In the program, some
guiding values are given for several types of soils, but it is
recommended that specialized literature and empirical data
from soil tests be consulted for more accurate values. Nor-

mally, if a geotechnical study has been carried out, it must
provide the exact value of this modulus for the dimensions
that the wall will have.

These Subgrade Moduli come to represent the stiffness of
the soil at a given point, and may differ according to the di-
rection of the displacement.

In addition, since the stiffness of the soil tends to increase
with depth, a linear variation may be considered, known as
the Gradient Subgrade Modulus, which the user introduces
as the increment of the modulus per foot of depth.

In this diagram, the soil is considered to behave plastically,
in a way that between one phase and the next, the diagram
is updated. The figure below shows this concept, where
δpre is the displacement of the previous phase:

Fig. 1.2

If the wall continues to displace to the right, a point is ob-
tained which moves on the load branch; while if its dis-
placement changes direction, the pressure will vary along
the unloading branch, which passes through the initial point.

At the points where the soil exists on both the exterior and
the interior, the behavior diagram employed is obtained by
adding the corresponding diagrams at that depth on either
side of the wall.

CYPE



9Embedded Retaining Walls

Fig. 1.3

1.2.1.Seismic Analysis

Seismic action makes the pressures on the wall increase
periodically.

The active pressure in seismic conditions is greater than
the corresponding one for the static situation.

Similarly, the passive pressure that the wall can exert on the
soil may be reduced considerably during seismic events.

To evaluate these pressures, a pseudo-static method has
been employed with the coefficients of dynamic pressures
based on the Mononobe-Okabe equations. For more infor-
mation, please consult the Earth pressure calculations
in section 3.

In the results of each construction phase, two graphs are
shown: the first without seismic action and the second with
seismic action.

Likewise, in the force reports, the results for anchorage ele-
ments, etc., both cases appear.

1.3. Reinforcement Code Checks

The procedure for checking the Code provisions applica-
ble to the reinforcement is as follows: first, the geometric
and strength criteria are verified for the horizontal and verti-
cal reinforcement. Then, the stiffeners are checked.

Geometric criteria include concrete cover, spacing limits,
and minimum and maximum reinforcement ratios. Strength
criteria follow the requirements for shear, combined bend-
ing and axial force, mechanical reinforcement ratios, and
lap splice lengths. For more information, please see the
Code checks report notes and the corresponding articles
in the Code.

For the strength checks, the program establishes sections
to verify every foot. In each one of the sections, the design
forces are obtained based on the results of each phase
and according to the following cases:

- C1: Axial, shear, and bending moment, multiplied by
the load factor.

- C2: Shear and bending moment, multiplied by the load
factor, with no axial force.

For the checks of ultimate limit states, the program applies
the load factor introduced by the user, which is a function of
whether the phase is a construction or service phase.

The forces are always calculated by panel and the Code
checks are carried out with respect to the resistant (effec-
tive) area of such panel, as indicated in the following figure.

Fig. 1.4
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10 Soil Retention Elements

The next sections expand on some of the critical checks as
well as those that the program verifies in addition to the
Code requirements.

1.3.1. Check for combined flexure and axi-
al load

The check for section strength (design strength) is carried
out using as a constitutive law the stress-strain diagram
with the simplified rectangle compression block. With this
principle, the program can also differentiate zones of
cracked concrete sections, due to combined forces, from
uncracked sections.

The combined flexure and axial load check is implemented
for all the Codes that the program allows for with their own
peculiarities with respect to compatibility formulations and
strains permitted for the materials that make up the section
(steel and concrete).

When the check is carried out, the program makes sure
that the reinforcement is anchored properly to be able to
consider them in the combined forces calculation.

1.3.2. Check for shear

The check for this ultimate limit state is carried out, as with
the combined flexure and axial load case, at different
heights of the wall. Since the wall has no transverse rein-
forcement, only the contribution of the concrete is consid-
ered for resisting shear forces.

The contribution of the concrete against shear is taken from
the term Vc, which is obtained from the simple empirical for-
mula stipulated by the Code. This term is a function of the
concrete strength and the width and effective depth of the
section.

1.3.3. Check for the horizontal stiffeners

The program verifies that: the diameter of the stiffener is at
least equal to the base reinforcement, they are uniformly

distributed along the whole height of the wall, and the spac-
ing is equal to or less than 8 ft.

These criteria have been extracted from the NTE (Spanish
Technological Standards for Buildings), Soil Preparation,
Foundations.

1.3.4. Check for the vertical stiffeners

The same checks as for the horizontal stiffeners apply, but
the spacing of the vertical stiffeners must be equal to or
less than 5 ft.

1.4. Design of the reinforcement
1.4.1. Design of the vertical reinforcement

From the total entries in the reinforcement table, the most
economic of all the ones that comply with the Code re-
quirements for strength, reinforcement ratios, spacing, etc.,
is selected. The base reinforcement, in addition to adhering
to the spacing and minimum ratio criteria, must cover at
least 50% of the zones where the maximum moment oc-
curs. In those regions where the base reinforcement does
not pass the checks, strengthening bars are provided.

In the cases where the bar lengths are greater than those in-
troduced by the user, the required lap splices are generated.

1.4.2. Design of the horizontal reinforce-
ment

From all the entries in the reinforcement table, the program
selects the most economical from those that meet the spac-
ing and quantity criteria described previously in section 1.3.

1.4.3. Design of the stiffeners

The diameter of the stiffener bar, vertical as well as horizon-
tal, must be equal to or greater than the largest diameter
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11Embedded Retaining Walls

used in either the exterior or interior face. A number of bars
are provided so that the spacing of the horizontal stiffeners
is at most 8 ft., and 5 ft. for the vertical stiffeners.

1.5. Design of secant pile walls

The design of reinforced concrete secant pile walls follows
the same procedure as for slurry  walls. All the reinforce-
ment Code Checks listed in section 1.3 apply except for
stiffeners which are not used in this type of walls.

1.6. Design of sheet pile walls

Once a series and a profile within the series have been cho-
sen, the design may proceed. In the case that the profile
does not meet the strength requirements, the program
places the next section in the series and analyzes the wall
again, since the stresses also change when the profile
changes. Next, the check is run once more, and if the new
section does not pass either, then the process is repeated.

The checks made on this type of wall are the following:

1.6.1. Stress with slenderness factor

Von Misses stress calculated from the normal stress (a
function of the axial force, effective length due to the slen-
derness, bending moment, and the section modulus) and
the tangent stress (a function of the shear force and the re-
sisting shear area).

1.6.2. Stress with top of wall load eccen-
tricity

In this case, rather than multiplying the axial force by the ef-
fective length factor as in the previous situation, the pro-
gram considers the additional moment calculated from the

product of the axial load at the top of the wall and the maxi-
mum eccentricity produced by the deformation of the wall.

1.6.3. Slenderness

The slenderness must not be greater than the value recom-
mended by the Code when the element is subject to com-
pression forces.

1.7. Design of Mini pile walls

Mini pile walls are cylindrical elements, drilled on site, rein-
forced with steel tubing and filled with grout or cement mor-
tar, and whose diameters do not usually surpass 12 in. The
user must define the exterior diameter or the excavation di-
ameter, and the program selects the cylindrical steel tube
from those defined in the library. The design of the Mini pile
follows from combined flexure and axial loads. For the cal-
culation of the concrete section in ultimate limit states, the
program uses the strain compatibility method, with the cor-
responding concrete and steel stress-strain diagrams. Be-
ginning with the section chosen for the job, all the sections
in the series are checked in sequence. A minimum or acci-
dental eccentricity is considered, as well as the buckling ec-
centricity based on the Code, limiting the value of the
mechanical slenderness, also as indicated by the Code.

The effective length considered is the clear distance in each
phase, taking into account that the embedded portion is
fixed, or the distance between points of zero moment
(when there are floor slabs, struts, etc., that produce inflec-
tion points in the bending moment diagram).

The maximum size of the circular tube is limited to the
diameter of the Mini pile.
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12 Soil Retention Elements

Fig. 2.1

2. Program Description

2.1. Assistants

When creating a new job, the Assistant Selection dia-
logue will open.

Fig. 2.2
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13Embedded Retaining Walls

If you create a new job with an Assistant, the program gen-
erates the data necessary to describe it, depending on the
type of Assistant selected, using a minimum number of pa-
rameters introduced in sequence. It includes the generation
of the construction process and the pre-dimensioning of
the geometry of a reinforced concrete slurry wall - excavat-
ed by phases with successive bracing (temporary or per-
manent). A wall that supports the various floors at the
different heights while considering the possibility of having
adjacent structures. It will also generate the final service
stage in which the wall is able to support the load of a build-
ing. Any data generated can be reviewed and/or modified
after the job has been created.

The pre-dimensioning of the wall thickness is H/20 (where
H is the excavation depth), with a minimum of 18 in. and a
maximum of 42 in. Rounding occurs to values of 18, 24, 32,
and 42.

The total height of the wall varies between 2H and 1.4H, de-
pending on whether the excavation is braced or not. A val-
ue within that range is chosen based on the number of
excavation phases. If rock exists at a shallower depth, the
wall will be embedded 4 in. into the layer; this is the mini-
mum value to consider the wall simply supported at that
point.

To understand the approximations made, read the help win-
dows for every dialogue of the Assistant.

There are two types of Assistants:

2.1.1. Assistant 1. Reinforced concrete
slurry wall for buildings

Assistant for the generation of walls of various levels. Data
entry dialogues appear successively and their options con-
tain on-screen help through the question mark icon. Note
that when an �elevation� is called for, one must introduce a
negative sign since the program takes the ground surface
as elevation 0'-0".

2.1.1.1. General data

One must indicate the total depth of the excavation.

Fig. 2.3

2.1.1.2. Soil

There is the possibility of introducing ground water, rock,
and a surcharge on the ground in the exterior. In addition,
one must configure the different soil layers found.

Fig. 2.4

2.1.1.3. Intermediate stages of excavation

One must define the number of excavation stages in which
anchors are placed, and for each, the elevation and type of
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14 Soil Retention Elements

anchor (strut, permanent or provisional active anchor, per-
manent or provisional passive anchor). The anchor has its
own elevation.

For each excavation stage, the Assistant generates 2 phas-
es. The first is the excavation of the ground, and the second
is the placement of the anchorage. The elevations of the ex-
cavation stages cannot be greater than the value of the total
excavation depth indicated in the first window of the Assist-
ant, General data. If, for example, the total depth of the ex-
cavation is 30 ft. and its excavation stages are of 10ft., only
two stages need to be defined: the first, at the elevation
-10 ft., and the second at -20 ft. The program automatically
generates the last excavation stage without an anchorage
phase.

Fig. 2.5

2.1.1.4. Floor slabs (construction phases)

This is the list of floors and foundation (if this exerts an an-
chorage type effect), indicating their top elevation, depth
(thickness), and shear load (in lbs/ft) in the construction
phase. Meaning that the slab on grade or mat foundation
must also be defined. The top elevation of the foundation
minus its depth must coincide with the elevation of the bot-
tom of the excavation, in this case: -50 ft. - 3 ft. = -53 ft.

Fig. 2.6

2.1.1.5. Service phase (finished job)

One may introduce the loads at the top of the wall, if any,
and the service phase shears that the basement floors
transfer to the wall.

Fig. 2.7

                                                                                                                                                                                                                                                                

2.1.2. Assistant 2. Reinforced concrete
slurry walls for buildings of one or two
basements

Just as with the previous Assistant, successive data entry
dialogues appear.

CYPE



15Embedded Retaining Walls

Fig. 2.8

2.1.2.1. Building

By default, one starts with one basement; if the corre-
sponding box is activated, a sub-basement may be estab-
lished. One must indicate the clear heights between floors,
transverse spans (free span of the floors between the wall
and the next support; with this data the program will ap-
proximate the depths of the floor slabs and the loads that
they transmit to the wall), whether the building is supported
by the wall (indicating the number of floors above ground
level), and, lastly, the type of foundation. With this last entry,
one informs the Assistant of the type of foundation for the
building.

Fig. 2.9

2.1.2.2. Adjacent property

Type of adjacent property (no adjacent structures, road
with light traffic, road with heavy traffic, or adjacent building
for which one must define the number of floors and the av-
erage height of its foundation). Based on the selection, a
surface load will be applied on the ground in the exterior.

Fig. 2.10

2.1.2.3. Soil

A maximum of two layers are allowed. One can also define
whether a rock layer or groundwater exists, indicating their
respective depths.

Fig. 2.11
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16 Soil Retention Elements

2.1.2.4. Information

Before creating the job, a list appears with all the data
entered and approximations made. At this point, one may
still go back and make changes, or otherwise wait for the
program to finish creating the job. This list can be printed
or exported to HTML, PDF, TXT, and RTF.

Fig. 2.12

2.2. Work mode

The following steps are recommended:

1. Create a New file with the name of the job.

2. Select the type of Assistant or rather, None. In the latter
case, one must create the construction phases or stag-
es manually with the Selection button and indicate all
the data necessary for each phase: depth of excava-
tion, anchors, etc.

3. Review the data introduced, browsing through the
phase selection.

4. Calculate and review the forces for each phase by click-
ing on the Forces button.

5. If the wall is a reinforced concrete slurry wall, click on the
Design button to obtain the reinforcement.

6. Review the Code checks report by clicking on the but-
ton with the same name.

7. Edit the reinforcement, if necessary, with the Reinforce-
ment Editor, and verify the Code requirements once
more with the Code checks button.

8. Obtain the job reports and plans by using the Job Re-
ports and Job Plans buttons respectively.

2.3. Program menus

The program menus and the dialogues that open when ex-
ecuting certain options have on-screen help available.

This help can be acquired in three different ways:

2.3.1. F1 Key

To obtain help about a menu option, place the cursor over
the menu option and, without clicking on it, press the F1 key.

2.3.2. Question mark icon

On the menu bar of the program�s main window there is an
icon with a question mark. You can obtain help about a
specific program option in the following way: click on the
icon; scroll down the desired menu option and place the
cursor over the command for which you would like help;
click on that command. Having done this, a window will ap-
pear with the desired help.

To deactivate this type of help, you can do one of the fol-
lowing: click on the right mouse button, click on the ques-
tion mark icon, or press the Esc key. One can also obtain
help on the toolbar icons. To do this, click on the question
mark icon. By browsing through the icons, a blue outline
will appear on those icons for which help is available. Next,
click on the desired icon to open the help window.
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17Embedded Retaining Walls

There also exists a question mark icon on the title bar of the
dialogues that are opened when selecting a program op-
tion. When clicking on this icon and browsing through the
dialogue window, the options that contain help will be high-
lighted in blue. Click on those options to open the help win-
dow.

2.3.3. Quick Guide

The information related to the menu options can also be
viewed and printed by choosing the option Help > Quick
Guide. The quick guide does not list information on the us-
age and options of the dialogues.

2.4. Assistant

When creating a new job, one has the option of using an
Assistant that will generate the data necessary to describe
the wall using a reduced number of parameters in se-
quence. It includes the pre-dimensioning of the geometry
and the generation of loads. Any data generated can be re-
viewed and/or modified once the job has been created.

2.5. Reports

The way to obtain job reports is through the File > Print
> Job Reports option or the printer icon on the upper
right hand corner of the main window.

The reports can be directed to a printer (with an optional
print preview, page adjustment, etc.) or one can generate
HTML, PDF, TXT, and RTF files (Fig. 2.13).

Fig. 2.13

2.6. Plans

The way to obtain job reports is through the File > Print
> Job Plans option or the plotter icon on the upper right
hand corner of the main window.

The following operations can be carried out for the drawing
of plans:

- The Plan selection window (Fig. 2.14) allows adding
one or various plans to print simultaneously and speci-
fy the peripheral of choice: printer, plotter, DXF, or
DWG; one may also select a title block (from CYPE or
any other defined by the user), and configure the lay-
ers.
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18 Soil Retention Elements

Fig. 2.14

- In each plan, one can configure the elements to print,
with the possibility of including previously imported
user details.

Fig. 2.15

- Modify the position of the texts.

Fig. 2.16

- Change the layout of the objects within the plan or
move them to another.

Fig. 2.17
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3. Earth pressure calculations

3.1. Introduction

The lateral earth pressures on a wall can be of the following
types:

� Active pressure. The soil exerts a pressure on the
wall allowing enough deformations in the direction of the
push to take the soil to a state of failure. This is the typi-
cal case when a soil �action� is developed.

� At rest pressure. The soil exerts a pressure, but the
wall does not suffer considerable deformations, that is,
they are null or negligible. The value of the pressure is
greater than the active.

� Passive pressure. When the wall displaces against
the soil, the soil is compressed and it reacts. This situa-
tion is always a �reaction�. Its value is much greater than
the active.

The parameters that characterize a layer of soil or fill are:

� Slope angle (βββββ). Expressed in degrees with respect to
the horizontal. Its limit is the internal friction angle.

� Apparent unit weight (γγγγγ). Also called the dry unit
weight.

� Submerged unit weight: (γγγγγ�). The unit weight of the
soil below the water table.

� Internal friction angle (ϕϕϕϕϕ). Intrinsic soil property that
describes the maximum natural slope angle at which
failure will not occur.

� Drainage loss (only in cantilever or basement
walls). Expressed as a %, allows the consideration of
infiltrated water in the soil that increases the lateral pres-
sure as an additional fraction of the hydrostatic pres-
sure and the partially saturated unit weight. A value X%
will produce a hydrostatic pressure of (100 - X) % and
an earth pressure according to the following unit weight:

( )partial
100 x' ' ' · 1

100
− γ = γ + γ − γ −  

The program considers the infiltrated water along the
whole height of the wall.

� Percentage of passive pressure (only in cantilev-
er or basement walls). Expressed as a % over the
passive pressure value.

� Elevation of passive pressure (only in cantilever
or basement walls). Elevation below which passive
pressure is considered (0 by default; then it will only act
in the footing, if passive pressure is considered).

� Rock. Activating this option permits defining a rock lay-
er, for which one must indicate the elevation, and this
must be lower than the fill elevation. From the rock ele-
vation down, all earth pressures are annulled, save for
the hydrostatic pressures.

� Water table. Above such level, the soil is considered
with its apparent unit weight γ or with the unit weight of
the partially saturated soil if the percentage of drainage
loss is under 100%. Below the water table, the sub-
merged unit weight γ� is used, additive to the hydrostat-
ic pressure to obtain total lateral pressures.

3.2. Static earth pressure

3.2.1. Calculation of the active pressure

The active pressure is resolved by applying Coulomb�s
theory.

The values of the horizontal and vertical pressures in a
point of the exterior located at a depth �z� are calculated
with:

CYPE
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h hp z= γ⋅ ⋅ λ   ;   v vp z= γ⋅ ⋅ λ

where:

( )
( ) ( )
( ) ( )

2

h 2
2

sin

sin · sin
sin · 1

sin · sin

α + ϕ
λ = =

 ϕ + δ ϕ − β
 α +

α − δ α + β  

λ = λ ⋅ α − δv h cot g ( )

z: depth

α: angle of the wall face with the horizontal

γ: unit weight of the soil

δ: wall-soil friction angle

ϕ: internal friction angle of the soil

β: angle of the slope

When the cohesion of the soil is considered:

h h hp z 2 c cos= γ⋅ ⋅ λ − ⋅ ⋅ λ ⋅ δ

where:

c = cohesion of the soil

3.2.2. Calculation of the passive pressure

The calculation of the passive pressure is similar to the cal-
culation of the active pressure. But one must change the
sign of the internal friction angle in the previous formulas.

Moreover, when the cohesion of the soil is considered:

h h hp z 2 c cos= γ⋅ ⋅ λ + ⋅ ⋅ λ ⋅ δ

where:

c = cohesion of the soil

3.2.3. Calculation of the �at rest� pressure

The �at rest� pressure is resolved by applying Jaky�s theory.
It is calculated as:

rest restp z K= γ⋅ ⋅

where:

restK 1 sin= − ϕ
z: depth
γ: unit weight of the soil
ϕ: internal friction angle of the soil

In the case where there is a slope or embankment, the
complementary formulation of the Corps of Engineers,
1961, is used.

3.2.4. Pressure from loads situated on the
ground
3.2.4.1.  Pressures produced by a uniformly
distributed load

Coulomb�s method is applied and the horizontal and verti-
cal pressures produced by a uniform surcharge equal:

Fig. 2.1
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h h
sin

p q
sin ( )

α= λ ⋅ ⋅ α + β   ;   v v
sin

p q
sin ( )

α= λ ⋅ ⋅ α + β

where:

λh: coefficient of horizontal pressure

λv: coefficient of vertical pressure

q: surface load

α: angle of the wall face with the horizontal

β: angle of the slope

3.2.4.2. Pressures produced by a band load
parallel to the top of the wall

The lateral pressure that a band load exerts for the case of
a vertical exterior face and a horizontal ground surface, fol-
lowing Elastic Theory, equals:

Fig. 2.2

( )q
2 qp sin cos 2⋅= ⋅ β − β⋅ ωπ

q: band load

β and ω: angles as described in the figure. The first in the formula
is measured in radians.

3.2.4.3. Pressures produced by a line load
parallel to the top of the wall

The method based on Elastic Theory has been employed.
The lateral pressure that a line load q exerts, for the case of
a vertical exterior face and a horizontal ground surface,
equals:

Fig. 2.3

2
q

qp sin 2
z

= ωπ⋅

3.2.4.4. Pressures produced by a point or
concentrated load in reduced areas (foot-
ings)

The method based on Elastic Theory has been employed.
The lateral pressure that a point surcharge exerts, for the
case of a vertical exterior face and a horizontal ground sur-
face, equals:

If (m < 0.4),

2
q 2 32

q np 0.28 · ·
H 0.16 n

=
 +  

CYPE



22 Soil Retention Elements

If (m ≥ 0.4),

 
2 2

q 2 32 2

m nqp 1.77 · ·
H m n

=
 +  

Fig. 2.4

3.2.4.5. Pressures from the �top of wall� loads

One may introduce point loads or a bending moment at the
top of the wall.

These loads generate forces on the wall directly, but they
may also have a passive response from the soil if that is
the case.

3.3. Dynamic earth pressure

Seismic action makes the pressures on the wall increase
periodically. The active pressure in seismic conditions is
greater than the corresponding one for the static situation.

Similarly, the passive pressure that the wall can exert on the
soil may be reduced considerably during seismic events.

To evaluate these pressures, a pseudo-static method has
been employed with the coefficients of dynamic pressures
based on the Mononobe-Okabe equations.

3.3.1. Calculation of the active pressure

3.3.1.1. Coefficient of active pressure in dy-
namic conditions

The coefficient of active pressure in dynamic conditions is
the following:

( ) *
ad a

cos
K K

cos cos
α + θ

= ⋅θ ⋅ α

where:

α: angle of the wall face with the vertical

θ: angle defined by the following expressions:

h

v

a
arctg

g a
 θ =  − 

Case 1

h d

v

a
arctg

g a '
γ θ = ⋅ − γ 

Case 2

where:

g: acceleration due to gravity

γd: dry unit weight

γsat: saturated unit weight

γ�: submerged unit weight

ah: design horizontal acceleration

av: design vertical acceleration, which the program takes as half
of the horizontal

K*
a the coefficient of active pressure in static conditions, but in its

calculation, α is replaced by (α + θ), and β by (β + θ).

Case 1 corresponds to dry or partially saturated soils in
the exterior, always located above the water table.

Case 2 corresponds to soils below the water table.
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3.3.1.2. Wall-soil friction angle

The wall-soil friction angle can decrease considerably dur-
ing seismic events. This leads to an additional increase of
the active pressure. Therefore, by considering an angle of
0, one remains on the side of safety.

3.3.1.3. Specific weight

The pressure due to the weight of the soil is greater since
there is an increase in the specific weight of the soil, above
as well as below the water table. The coefficient to apply to
the unit weight, which the program considers automatically,
is:

va
f 1

g
= +

where:

av: design vertical acceleration = 1/2  · ah  

g: acceleration due to gravity

3.3.1.4. Pressure from groundwater

Below the water table, the increase in pressure at each
point is calculated as:

h
w w z

a7E h
8 g

∆ = ⋅ ⋅ γ

where:

ah: design horizontal acceleration

g: acceleration due to gravity

hz: depth

γw: unit weight of water

3.3.1.5. Effects of the loads and surcharge in
the exterior

The intensity of the loads on the ground shall be multiplied
by:

va
f 1

g
= +

where:

av: design vertical acceleration = 1/2 · ah

g: acceleration due to gravity

3.3.2. Calculation of the passive pressure

The passive pressure can decrease during a seismic event.

The coefficient of passive pressure in dynamic conditions
is the following:

( )α − θ
= ⋅θ ⋅ α

*
pd p

cos
K K

cos cos

where:

α: angle of the wall face with the vertical

θ: the same angle defined for the active pressure case

K*
p: the coefficient of passive pressure in static conditions, but in

its calculation, α is replaced by (α - θ), and β by (β - θ).

3.3.2.1. Specific weight

The pressure due to the weight of the soil is smaller. The
coefficient to apply to the unit weight, which the program
considers automatically, is:

va
f 1

g
= −

where:

av: design vertical acceleration = 1/2 · ah

g: acceleration due to gravity
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4. Questions and Answers

For Users in the United States:

Please contact your local Authorized Dealer.

For Users in Europe:

In the web page (http://www.cype.com), in the Technical
Support Section, you can find the link to FAQ, which con-
tains the answers to the most frequently asked questions,
constantly updated, received by the Technical Support
Department of CYPE Ingenieros.

CYPE
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